Installation Instructions

EtherNet/IP-to-DeviceNet Linking Device

Catalog number 1788-EN2DN
This publication tells you how to install the 1788-EN2DN EtherNet/IP-to-DeviceNet
linking device and use RSNetWorx for DeviceNet to configure it.
For information on
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About the Linking Device
The 1788-EN2DN EtherNet/IP-to-DeviceNet linking device lets you seamlessly connect
your information- or control-level networks with your device-level network.
The linking device provides full DeviceNet master functionality, so you can connect up to 63
DeviceNet slave devices to an Ethernet TCP/IP interface that supports EtherNet/IP and a
HTTP web server. As examples, you could use the linking device:
• as a gateway to connect information- or control-level networks to device- level
networks for programming, configuration, control or data collection
• as a router/bridge to connect the EtherNet/IP network to the DeviceNet network
The linking device provides centralized data storage, or I/O tables, for data shared between
the DeviceNet and EtherNet/IP networks. Data is placed into the I/O tables by one network
interface, allowing the data to be read through the other network interface.
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The linking device appears as a single device on either network using standard protocol
mechanisms. No special, or extended, protocol features are required for the devices on either
network to read or write the data flowing through the I/O tables; all cross-network activity is
transparent to the devices on either network.
All connections, whether power or fieldbus, to the linking device are made on one end of the
module. Phoenix connectors are provided for power and DeviceNet connections. A RJ-45
style connector is provided for EtherNet/IP connection.
The linking device can be mounted to a DIN rail.

Important User Information
Because of the variety of uses for the products described in this publication, those responsible for the
application and use of these products must satisfy themselves that all necessary steps have been taken to
assure that each application and use meets all performance and safety requirements, including any applicable
laws, regulations, codes and standards. In no event will Rockwell Automation be responsible or liable for
indirect or consequential damage resulting from the use or application of these products.
Any illustrations, charts, sample programs, and layout examples shown in this publication are intended solely
for purposes of example. Since there are many variables and requirements associated with any particular
installation, Rockwell Automation does not assume responsibility or liability (to include intellectual property
liability) for actual use based upon the examples shown in this publication.
Allen-Bradley publication SGI-1.1, Safety Guidelines for the Application, Installation and Maintenance of
Solid-State Control (available from your local Rockwell Automation office), describes some important
differences between solid-state equipment and electromechanical devices that should be taken into
consideration when applying products such as those described in this publication.
Reproduction of the contents of this copyrighted publication, in whole or part, without written permission of
Rockwell Automation, is prohibited.
Throughout this publication, notes may be used to make you aware of safety considerations. The following
annotations and their accompanying statements help you to identify a potential hazard, avoid a potential
hazard, and recognize the consequences of a potential hazard:

WARNING

!
ATTENTION

Identifies information about practices or circumstances that can cause an explosion in a
hazardous environment, which may lead to personal injury or death, property damage,
or economic loss.

Identifies information about practices or circumstances that can lead to personal injury
or death, property damage, or economic loss.

!
IMPORTANT

Identifies information that is critical for successful application and understanding of the
product.
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Environment and Enclosure
This equipment is intended for use in a Pollution Degree 2 industrial
environment, in overvoltage Category II applications (as defined in IEC
publication 60664-1), at altitudes up to 2000 meters without derating.
This equipment is considered Group 1, Class A industrial equipment
according to IEC/CISPR Publication 11. Without appropriate
precautions, there may be potential difficulties ensuring electromagnetic
compatibility in other environments due to conducted as well as radiated
disturbance.
This equipment is supplied as “open type” equipment. It must be
mounted within an enclosure that is suitably designed for those specific
environmental conditions that will be present and appropriately designed
to prevent personal injury resulting from accessibility to live parts. The
interior of the enclosure must be accessible only by the use of a tool.
Subsequent sections of this publication may contain additional
information regarding specific enclosure type ratings that are required to
comply with certain product safety certifications.
NOTE: See NEMA Standards publication 250 and IEC publication
60529, as applicable, for explanations of the degrees of protection
provided by different types of enclosures. Also see the appropriate
sections in this publication, as well as the Allen-Bradley publication
1770-4.1 (“Industrial Automation Wiring and Grounding Guidelines”),
for additional installation requirements pertaining to this equipment.

ATTENTION

!

Preventing Electrostatic Discharge
This equipment is sensitive to electrostatic discharge, which can cause
internal damage and affect normal operation. Follow these guidelines
when you handle this equipment:
•
•
•
•
•
•

Touch a grounded object to discharge potential static.
Wear an approved grounding wriststrap.
Do not touch connectors or pins on component boards.
Do not touch circuit components inside the equipment.
If available, use a static-safe workstation.
When not in use, store the equipment in appropriate static-safe
packaging.
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ATTENTION

!

This Product is grounded through the DIN rail to chassis ground. Use
zinc plated yellow-chromate steel DIN rail to assure proper grounding.
The use of other DIN rail materials (e.g. aluminum, plastic, etc.) that can
corrode, oxidize, or are poor conductors, can result in improper or
intermittent grounding.

European Hazardous Location Approval
If you install the module in a European Zone 2 location, consider:
European Zone 2 Certification
This equipment is intended for use in potentially explosive atmospheres as defined by
European Union Directive 94/9/EC.
DEMKO certifies that this equipment has been found to comply with the Essential Health
and Safety Requirements relating to the design and construction of Category 3 equipment
intended for use in potentially explosive atmospheres given in Annex II to this Directive.
Compliance with the Essential Health and Safety Requirements has been assured by
compliance with EN 50021.

IMPORTANT

When using this product, also consider the following:
• This equipment is not resistant to sunlight or other sources of
UV radiation.
• The secondary of a current transformer shall not be
open-circuited when applied in Class I, Zone 2 environments.
• Equipment of lesser Enclosure Type Rating must be installed
in an enclosure providing at least IP54 protection when
applied in Class I, Zone 2 environments.
• This equipment shall be used within its specified ratings
defined by Allen-Bradley.
• Provision shall be made to prevent the rated voltage from
being exceeded by transient disturbances of more than 40%
when applied in Class I, Zone 2 environments.
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North American Hazardous Location Approval
The following information applies when
operating this equipment in hazardous
locations:

Informations sur l’utilisation de cet équipement en
environnements dangereux:

Products marked “CL I, DIV 2, GP A, B, C, D” are
suitable for use in Class I Division 2 Groups A, B, C, D,
Hazardous Locations and nonhazardous locations only.
Each product is supplied with markings on the rating
nameplate indicating the hazardous location
temperature code. When combining products within a
system, the most adverse temperature code (lowest
“T” number) may be used to help determine the
overall temperature code of the system. Combinations
of equipment in your system are subject to
investigation by the local Authority Having
Jurisdiction at the time of installation.

Les produits marqués "CL I, DIV 2, GP A, B, C, D" ne
conviennent qu’à une utilisation en environnements de
Classe I Division 2 Groupes A, B, C, D dangereux et non
dangereux. Chaque produit est livré avec des marquages
sur sa plaque d’identification qui indiquent le code de
température pour les environnements dangereux.
Lorsque plusieurs produits sont combinés dans un
système, le code de température le plus défavorable
(code de température le plus faible) peut être utilisé pour
déterminer le code de température global du système.
Les combinaisons d’équipements dans le système sont
sujettes à inspection par les autorités locales qualifiées
au moment de l’installation.

WARNING

!

EXPLOSION HAZARD
• Do not disconnect equipment
unless power has been
removed or the area is known
to be nonhazardous.
• Do not disconnect
connections to this
equipment unless power has
been removed or the area is
known to be nonhazardous.
Secure any external
connections that mate to this
equipment by using screws,
sliding latches, threaded
connectors, or other means
provided with this product.

AVERTISSEMENT

!

• Substitution of components
may impair suitability for
Class I, Division 2.
• If this product contains
batteries, they must only be
changed in an area known to
be nonhazardous.

RISQUE D’EXPLOSION
• Couper le courant ou
s’assurer que
l’environnement est
classé non dangereux
avant de débrancher
l'équipement.
• Couper le courant ou
s'assurer que
l’environnement est
classé non dangereux
avant de débrancher les
connecteurs. Fixer tous
les connecteurs externes
reliés à cet équipement à
l'aide de vis, loquets
coulissants, connecteurs
filetés ou autres moyens
fournis avec ce produit.
• La substitution de
composants peut rendre
cet équipement inadapté
à une utilisation en
environnement de Classe
I, Division 2.
• S’assurer que
l’environnement est
classé non dangereux
avant de changer les
piles.

DeviceNet is a trademark of Open Device Vendor Association (ODVA), Inc.
EtherNet/IP is a trademark of ControlNet International LTD.
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RSLinx, RSLogix, and RSNetWorx are trademarks of Rockwell Software.
MS-DOS and Windows are trademarks of the Microsoft Corporation.

System Requirements
The following hardware and software components are required to use the linking device.

Required Hardware
• 1788-EN2DN linking device
• DeviceNet cabling, power, and devices forming a DeviceNet network
• Ethernet cabling and power
• PC or other controller with access to the Ethernet network
• PC running DeviceNet Configuration Software. The DeviceNet slave devices with
which the linking device communicates are specified using a DeviceNet
Configuration Software tool such as RSNetWorx for DeviceNet.
• 24V dc power to the linking device (DeviceNet power may be used)

Required Software
• DeviceNet configuration software such as RSNetWorx for DeviceNet, version 4.01
or later to configure DeviceNet devices and the linking device’s DeviceNet
functionality
• RSLinx version 2.31 or later
• Rockwell Automation BOOTP/DHCP Server version 2.3.2.0 or later
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Installing and Configuring the Linking Device
WARNING

!

• If you connect or disconnect the communications cable with
power applied to this module or any device on the network, an
electrical arc can occur. This could cause an explosion in
hazardous location installations.
• When used in a Class I, Division 2, hazardous location, this
equipment must be mounted in a suitable enclosure with proper
wiring method that complies with the governing electrical codes.
• If you insert or remove the card while host power is on, an
electrical arc can occur. This could cause an explosion in
hazardous location installations.
• If you connect or disconnect wiring while the field-side power is
on, an electrical arc can occur. This could cause an explosion in
hazardous location installations. Be sure that power is removed or
the area is nonhazardous before proceeding.

Follow these steps to install the linking device (described in the sections that follow):

Step 1: Connect the Linking Device to the EtherNet/IP Network
Connect the EtherNet/IP network cable to the RJ-45 port on the end of the linking device.

Figure 1 Power and Network Connections
DeviceNet Connection
Power Connection

Configuration DIP
switch

31480-M
RJ-45 port (EtherNet/IP connection)
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Step 2: Connect the Linking Device to the DeviceNet Network
1. Make sure a PC running RSNetWorx for DeviceNet is connected to the EtherNet/IP
network.
2. With power to the linking device off, connect the DeviceNet network cable to the
DeviceNet connector on the linking device. The female terminal block connector is
provided with the linking device.

(Red) Net Power 24V dc
(White) CAN High +
CAN Shield
(Blue) CAN Low
(Black) Net Power 24V dc Common 31442-M

TIP

Two 120 ohm termination resistors (supplied with the linking device)
may be required for proper network termination at each end of the
trunk line. See the DeviceNet Specification (available from the Open
DeviceNet Vendors Association at www.odva.com) for specific rules
on DeviceNet connections and termination.

3. Connect the power cable to the linking device. See Figure 1 on page 7. The female
terminal block connector is provided with the linking device.

24V dc common
24V dc +
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4. Power up the linking device and DeviceNet network.
IMPORTANT

The linking device defaults to Autobaud. This means that the linking
device automatically finds the network baud rate at power-up. You must
have installed a device, such as a DeviceNet Bridge Module (1756-DNB)
so that the linking device can pick up the correct baud rate. If you do not
have another device installed, you must use RSNetWorx for DeviceNet to
set the baud rate, as described in “Step 6: Set the DeviceNet MAC ID and
Baud Rate” on page 17. Do not attempt to commission the linking device
on a network configured at a different baud rate.

Step 3: Configure the Linking Device IP Address
Several methods may be used to set the IP Address. These methods include:
• IP address configuration DIP switch
• DHCP protocol
• web page

Setting the IP Address with the Configuration DIP Switch
A configuration DIP switch on the end of the linking device lets you set the IP address. See
Figure 1 on page 7 to locate the switch. If the configuration DIP switch is set to 1 (in the up
position, as shown in Figure 2), on power-up the value of the switch creates the IP address of
192.168.1.1.
IMPORTANT

The numbers that appear above the switches on the DIP switch do not
correspond to bit locations in the address value. In fact, the numbers on
the switch are opposite the address value bit locations; i.e., bit 0 is set by
switch 8.

Figure 2 IP Address Configuration DIP Switch

7

8

2

6

3

5

4

4

5

3

6

2

7

1
ON

8

1 ON

31421-M
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The switch represents the binary value of the last byte in the 4-byte IP address. In this case it
is n. If n = 0, the linking device obtains its IP address from the software configuration (DHCP
or web page).
IP address

192.168.1.n

Subnet mask

255.255.255.0

Gateway address

0.0.0.0 (No gateway set)

Setting the IP Address Using DHCP/BootP

TIP

The use of DHCP is the default configuration for the linking device as
shipped. The IP address configuration DIP switch ships with n = 0.

When DHCP/BootP is enabled and a DHCP or BootP server is found, the IP address,
Subnet mask, and Gateway address are automatically configured by the DHCP server, as
shown in the figure below.
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You can change the IP address, Subnet mask, and Gateway address from this screen. To do
this:
1. Click New. You see the Properties screen.

2. In the Properties screen that appears, enter the following:
• Ethernet address (MAC ID) [from the linking device product ID label]
• IP address
• Subnet Mask
• Gateway (IP address)
3. Click Ok.
Figure 3 shows a flowchart describing how the IP configuration is determined when the
linking device is powered up.
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Figure 3 Configuration Initialization Sequence
Start

Valid
Configuration
in Flash Memory?

No

Yes

DIP Switch = 0

Yes
No

Request config
from DHCP/
BOOTP Server.
Timeout 30 secs

Use received
configuration

Yes

Yes

DHCP
Config
Received?

DHCP
Enabled?

IP = 192 168.1.n
Sub = 255.255.255.0
No Gateway

No

No

Valid
Configuration
File?

Yes

Use Valid (stored)
IP address

No

Remain offline

Stop

TIP

31445-M

You can enable these values using the linking device’s IP
Configuration web page. Refer to Setting the IP Address Using the
Web Page on page 13.
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Setting the IP Address Using the Web Page
The EtherNet/IP address can also be configured using the IP Configuration web page on the
linking device, as shown in the figure below.

The IP address can be set with the web page only if the linking device already has a valid IP
address. Typically, you can do this by using the DIP switch to force the linking device to use a
temporary IP address after you cycle power. To configure the IP address with the web page:
IMPORTANT

Because the DIP switch setting overrides other IP address configurations,
be sure to set the DIP switch to the 0 position before continuing.

1. Browse to the linking device by entering the temporary IP address in your web
browser’s address bar and click Enter.
2. In the left pane, click on IP Configuration. You see the Enter Network Password
screen.
3. In the Username field, enter Administrator.
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4. Leave the password field blank.

5. Click Ok. You see the IP Configuration screen.

6. Enter the following values into the IP Configuration screen.
In this field

Enter

IP Address

Any valid value. See your system
administrator for a valid IP address.

Subnet Mask
Gateway IP Address
DHCP enabled
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7. Click Submit Values.
8. Follow the on-screen prompts.
9. Click the Reset Module button to reset the linking device.

Step 4: Register the Driver in RSLinx
1. In RSLinx software, select Communications ⇒Configure Driver.
2. In the Configure Drivers menu, select Ethernet Devices from the Available Driver
Types pull-down menu.
3. Click Add New.
4. In the Add New RSLinx Drivers pop-up menu, click Ok.
5. In the Configure Driver window that appears, enter the IP address of the linking
device.
6. Click Close.
7. Click Ok.

Step 5: (Optional) Register the EDS file in RSNetWorx
RSNetWorx for DeviceNet software requires an electronic data sheet (EDS) to recognize a
device and its capabilities. If you do not already have a registered EDS file for the device, you
can download an EDS file from www.ab.com/networks.
IMPORTANT

If RSLinx or RSNetWorx for DeviceNet software cannot find the EDS
file for the linking device, the linking device’s icon may be labeled an
“unrecognizable device” in the software.

1. In RSNetWorx for DeviceNet software, select Tools ⇒EDS Wizard.
2. Click Next.
3. Select Register an EDS File and click Next.
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4. Select Register a Single File and enter or browse to the location of the EDS file for
the linking device.
5. Click Next or Finish for the remaining option screens.

Step 6: Use RSNetWorx for DeviceNet Software to Locate the Module on
the Network
1. In RSNetWorx for DeviceNet, select Network ⇒Online.
2. In the left pane, click on the RSLinx Ethernet driver you added previously (in step 5).
3. In the left pane, click on the + next to the 1788-EN2DN linking device icon.
4. In the left pane, click on DeviceNet, DeviceNet.

5. When asked to upload from the network, click Ok to perform a single pass browse.
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Step 6: Set the DeviceNet MAC ID and Baud Rate
1. In RSNetWorx for DeviceNet software, select Tools ⇒Node Commissioning. You
see the Node Commissioning screen.
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2. On the Node Commissioning screen, click Browse. You see the Device Selection
screen.

3. In the left pane, click on the + next to the RSLinx driver for the 1788-EN2DN
linking device.
4. In the left pane of the screen, click on the + next to the IP address for the
1788-EN2DN linking device.
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5. In the left pane, click on the + next to the DeviceNet network. You see the
1788-EN2DN linking device in the left pane.
6. Click on the 1788-EN2DN linking device in the left pane. It appears in the right pane.
7. Click Ok.
8. If a warning text box asking you if you wish to continue appears, click Yes.
9. Enter the desired MAC address and/or data rate, then click Apply

10. Click Close.
IMPORTANT

The linking device will automatically reset if a new MAC ID is entered. If
only the baud rate is changed you must cycle power to the linking device
before the new baud rate will take effect.
When the MAC ID is changed, the linking device’s I/O configuration is
cleared.
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TIP

If you are using the linking device as a network gateway, you may need
to re-start RSNetWorx for DeviceNet software before continuing.

11. Re-start RSNetworx for DeviceNet software and go online.

Step 7: (Optional) Disable Autobaud
If you do not want the linking device to automatically determine the network baud rate,
disable Autobaud. By default, the linking device has Autobaud enabled.
1. In RSNetWorx for DeviceNet software, highlight the linking device by left-clicking on
its icon.
2. From the pull-down menu, select Device ⇒Class Instance Editor. If a warning text
box appears, click Yes.
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3. You see the Class Instance Editor screen. From the pull-down menu, select
Description ⇒Set Single Attribute.

In this field

select

Object Address
Class
Instance
Attribute

3
1
64h

Data Sent to Device

00 to enable Autobaud
01 to disable Autobaud

Transmit Data Size

Byte

IMPORTANT

Make sure the check box titled Values in Decimal is NOT checked.
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4. Click Execute. You should see a message in the Data received from device dialog box
indicating that the execution was completed.

IMPORTANT

IMPORTANT

Changes to the autobaud option configuration do not take effect until you
cycle power to the linking device. You may also have to cycle power to the
slave devices.
If the linking device is the only master on the DeviceNet network, do not
enable autobaud. Automatic baud detection requires there to be traffic on
the network. There is typically no traffic until the master establishes
connections.

5. Click Close.
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Step 8: (Optional) Configure DeviceNet I/O
IMPORTANT

Steps 8 and 9 are required only if the linking device is used as an I/O
scanner. The linking device can function as a gateway/bridge, even if no
I/O is configured.

I/O Mapping
The DeviceNet I/O configuration defines the format of the Input and Output tables, or the
mapping of DeviceNet slaves’ I/O data to the I/O tables. As slaves are added to the linking
device’s DeviceNet scanner configuration, the location in the I/O tables of each part of the
slave’s I/O data is determined and stored.
IMPORTANT

The organization of the I/O tables is very important. I/O tables define
the format of the data that will be provided to the EtherNet/IP scanner.
The Input and Output table formats should be planned and documented
to ensure the EtherNet/IP scanner is working with the correct data from
the DeviceNet network.
The size of the I/O data that can be exchanged with the EtherNet/IP
scanner (and, hence, the size of the I/O tables) is restricted as explained
below.
• The Input table size cannot be larger than 496 bytes.
• The Output table size cannot be larger than 492 bytes.
• Either table may be empty (0 bytes).

To configure DeviceNet I/O, use RSNetWorx for DeviceNet software to set the linking
device’s scan list and I/O table mapping.
IMPORTANT

Automap is used in this example for simplicity. In some cases, you may
want to organize the I/O data in other ways; you can do this using the
Advanced data table editor in the Input and Output tabs. Refer to
RSNetWorx online help for complete details.

1. In RSNetWorx for DeviceNet, go online by selecting Network ⇒Online.
2. Select Network ⇒Single Pass Browse. Wait for browsing to complete.
3. Select Network ⇒Upload from Network. Wait for the device information to be
uploaded from the network.
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4. Double-click on the linking device icon to bring up the Module Description screen.

5. Several tabs appear on the top of the screen. Click the Scanlist tab.
6. In the informational text box that appears, click Upload.
The screen shows 2 columns. On the left is a list of available devices that may be
added to the scan list. On the right is a list of devices that are configured in the scan
list.
7. Check the AutoMap on Add check box.
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8. Select the I/O devices on the left side of the screen. Click > to move it to the right
side of the screen.

9. Select the Input tab. The Input mapping screen is displayed.
The top portion of this screen gives a
list of the devices in the scan list from
which the linking device receives
input data. The bottom shows the
location in the Input table where the
data will be placed for each device.
This shows the format of the Input
table of the linking device. This is
the format of the input data that
will be sent to the EtherNet/IP
scanner.
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10. Select the Output tab. The Output mapping screen is displayed.
The top portion of this screen gives a
list of the devices in the scan list to
which the linking device will send
output data. The bottom shows the
location in the Output table where the
data will be placed for each device.
This shows the format of the
Output table of the linking device.
This is the format of the output
data that will be sent to the
linking device from the
EtherNet/IP scanner.

11. Click Apply, and click on Yes to download the scanlist to the linking device.

TIP

The linking device starts scanning as soon as it finds entries in its
scanlist. However, in Idle mode, output data will not be sent to the
devices.

12. Click Ok.

Step 9: (Optional) Add the Linking Device to an RSLogix 5000 Project
1. Create a new project in RSLogix 5000. Select File ⇒New. You see the New
Controller screen.
2. From the Type pull-down menu, select the controller type.
3. From the Revision pull-down menu, select the controller version.
4. Enter a name for the controller project.
5. Click Ok. A project is created.
6. In the left pane, right-click I/O Configuration. Left-click on New Module.
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7. In the Select Module Type menu, select any EtherNet/IP Bridge Module (such as the
1788-ENBT module).
8. Click Ok. You see the Module Properties screen.

9. In the Slot Number field, enter the slot number in which the device resides.
10. Click Finish.
11. In the right pane, right-click on the EtherNet/IP module you just added to your
project.
12. Left click on New Module.
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13. In the Select Module Type menu, select Generic Ethernet Module.

14. Click Ok. You see the Module Properties screen.
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in this field

enter or select

Name

a module name

Comm Format

Data - DINT - With - Status

29

15. Click the IP Address radio button and enter the IP address for which the linking
device is configured.
16. Enter the following connection parameters:
Table 1 Connection Parameters
assembly instance

size (DINT)

Input

100

1 -125 (125 max.)

Output

150

1 - 124 (124 max.)

Configuration

1

0

Status input

101

1 - 32 (32 max.)

Status output

3

None

17. Click Next.
18. Click the Connection tab. Enter the Requested Packet Interval (RPI or update rate)
in a range from 2 to 750ms.

If you see errors in this
field when you are online,
see Table 2 on page 30.
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Table 2 RSLogix 5000 Error Codes
this error
code

means

so you should

16#0203

Connection timed out

Check IP configuration and Ethernet cabling

16#0204

Connection Request Error: Connect
request timed out

Check IP configuration and Ethernet cabling

16#0103

Service Request Error: CIP
transport class not supported.

Check for valid RPI range (i.e., 2-3200ms)

16#0005

Connection Request Error: Bad
class.

Check for correct assembly instance numbers
in connection parameters

19. Click Finish. You can now use the linking device as both a bridge and a scanner
20. Write a user program to use the linking device on the network. Consult Rockwell
Automation Technical Support or your Rockwell Automation representative for
assistance in writing the program.
21. To view information specific to the RSLogix 5000 tags that pertain to the linking
device, do the following:
a. In the left pane of the RSLogix 5000 window, click on Controller Tags. In the
right pane, you see the 1788-EN2DN linking device controller tags.

b. Click on the + to the left of the tag name to expand it.
c. Review data in the fields that appear for each tag, as described in the section
entitled “Assembly Objects and Connections,” below.
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Assembly Objects and Connections
Three Assembly Object instances are accessible from EtherNet/IP: input, output and status.
The input and output assemblies are linked to the input and output tags created in
RSLogix 5000 software. The status assembly provides current status information about the
linking device.
With a generic profile for the linking device, I/O tags are offset by one
DINT compared to input and output mapping found in RSNetWorx for
DeviceNet. For example, the RSLogix 5000 input tag EN2DN:I.Data[1]
corresponds to word 0 of the RSNetWorx Input Mapping table. Tag
EN2DN:I.Data[0] contains module status.

IMPORTANT

The assembly instances associated with these 3 assemblies are listed in Table 1 on page 29.
Input Assembly
The input assembly contains a 32-bit status register followed by the data in the linking device’s
input data table.
Table 3 Input Assembly Format
DINT offset

size in DINTs

description

RSLogix 5000 example tags

0

1

Status register

EN2DN:I.Data[0]

1

Up to 123

Input data

EN2DN:I.Data[1 - 124]

The input data format and content is determined by the DeviceNet scanner configuration.
The data appears in the table as it is mapped from the DeviceNet input connections. The
input data in the assembly is 124 DINTs long; however, only the size of the input data table
will be used. The remaining space will be filled with the value 0 (zero).
The status register is a bit string with the following bit definitions.
Table 4 Input Status Register Bit Definitions
Bit

Description

0

EN2DN is in Run mode (Cleared if in Idle mode)

1

EN2DN is faulted

2

DeviceNet network interface is disabled

3

Communication has failed with at least 1 DeviceNet slave

4

At least 1 DeviceNet slave is an incorrect device type

5

DeviceNet network interface is bus-off
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Table 4 Input Status Register Bit Definitions
Bit

Description

6

Duplicate MAC ID error

7

No DeviceNet power

8-31

Not used

Output Assembly
The output assembly contains a 32-bit command register followed by the data in the linking
device’s output data table.
Table 5 Output Assembly Format
DINT offset

size in DINTs

description

RSLogix 5000 example tags

0

1

Command register

EN2DN:O.Data[0]

1

Up to 123

Output data

EN2DN:O.Data[1 - 123]

The output data format and content is determined by the DeviceNet scanner configuration.
The data appears in the table as it is mapped to the DeviceNet output connections. The
output data in the assembly is 123 DINT long; however, only the size of the output data table
will be used. The remaining space will be ignored.
The command register is a bit string with the following bit definitions.
Table 6 Output Command Register Bit Definitions
Bit

Description

0

Run mode
Sets the linking device to Run mode when set
Sets the linking device to Idle mode when cleared
For the linking device to be in Run mode, both of these bits must be set and the
controller must be in Run mode

1

Fault. Sets a fault condition in the linking device

2

Disable DeviceNet network

3

Not used

4

Reset the linking device

5-31

Not used
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Status Assembly
The status assembly is a collection of status and diagnostic information for the linking
device’s DeviceNet interface. The information in the assembly is updated once a second.
All information in the status assembly is stored in little endian format.
The least significant byte of multi-byte values is stored first.

IMPORTANT

Table 7 Status Assembly Format
Byte Offset

Size in Bytes

Data Type

Name

Description

0

4

UDINT

Scan Counter

The number of DeviceNet I/O
scans that have taken place since
the linking device was powered up

4

8

64-bit Bitstring

Faulted Node
Table

Indicates which DeviceNet slaves
are faulted. Each bit represents
the status of the slave at the
corresponding MAC ID.

12

8

64-bit Bitstring

Auto Verify Error
Table

Indicates which DeviceNet slaves
are the incorrect device type. Each
bit represents the status of the
slave at the corresponding MAC
ID.

20

8

64-bit Bitstring

Idle Node Table

Indicates which DeviceNet slaves
are in Idle mode. Each bit
represents the status of the slave
at the corresponding MAC ID.

28

8

64-bit Bitstring

Active Node
Table

Indicates which DeviceNet nodes
are configured in the EN2DN’s
scan list. Each bit represents the
status of the slave at the
corresponding MAC ID.

36

4

ASCII[4]

Status Display

Mimics a 4-character
alpha-numeric display. If there are
no faults, the display shows the
linking device’s MAC ID and its
Run/Idle status.
If there are faults, the display will
scroll through the MAC IDs of the
faulted nodes and display the error
code associated with each.

40

1

USINT

EN2DN MAC ID

The DeviceNet MAC ID of the
linking device
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Table 7 Status Assembly Format (Continued)
Byte Offset

Size in Bytes

Data Type

Name

Description

41

1

USINT

Scanner Status

The current status of the
DeviceNet scanner

42

1

USINT

Scrolling MAC ID

43

1

USINT

Scrolling Status

The scrolling address and status
fields scroll through the address
and status of all DeviceNet slaves
that are faulted. This scrolling
includes the linking device
scanner itself.
If there are no faulted nodes, both
the scrolling address and status
are set to 0.
The scrolling fields change once a
second.

44

20

USINT[20]

Reserved

64

64

USINT[64]

Node Status
Table

The current status of each
DeviceNet slave node. Each array
element is the status of the node
at the corresponding MAC ID.
If a node is not configured in the
linking device scan list, the status
value will be set to 0.
The linking device scanner status
appears at the entry associated
with the linking device MAC ID.

Understanding Status and Diagnostic LEDs
A group of LED indicators on the front panel of the linking device shows the current status
of the linking device and the network interfaces. See Figure .
The following tables provide information on status LED states.
for information about the

see

on page

I/O Status LED

Table 8

36

DeviceNet Network Status LED

Table 9

36

Module Status LED

Table 10

36
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for information about the

see

on page

Ethernet Link LED

Ethernet Link
LED

37

EtherNet Network Status LED

Table 11

37

CIP Link LED

CIP Link LED

37

35

CIP Link
LED
Ethernet
Link LED

DeviceNet
Network
Status LED

I/O Status
LED
EtherNet
Network
Status LED

Module
Status LED
31441-M

I/O Status LED
TIP

If the I/O Status LED is flashing red and green for an extended
period of time, count the number of red and green flashes and call
Rockwell Automation technical support. Refer to the back cover of
this publication for details on contacting technical support.
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Table 8 I/O Status LED States
state

summary

description

Flashing Green

Idle

Module is in Idle mode

Solid Green

Running

Module is in Run mode

Solid Orange

Hardware
Initialization

The LED will be in this state immediately after
power is applied

Flashing Red/Green

Error

A fault has been detected

Off

No I/O

No DeviceNet I/O configured

DeviceNet Network Status LED
Table 9 DeviceNet Network Status LED States
state

summary

description

Solid Green

Online and
communicating

The linking device is on the DeviceNet network and
communicating with at least 1 device

Flashing Green

Online, no
communication

The linking device is on the DeviceNet network and
is not currently communicating with any devices

Solid Red

DeviceNet interface
fault

A major fault in the DeviceNet interface has been
detected. Possible causes include Bus-off or
duplicate MAC ID.

Flashing Red

Connection time-out

A connection with at least 1 slave device has timed
out

Module Status LED
Table 10 DeviceNet Module Status LED States
state

summary

description

Flashing Green

Standby or not
configured

The module has not been configured and is currently
using default values.
This LED state is also used to indicate that the
module is in a standby state. This could occur during
initialization or DeviceNet autobaud.
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Table 10 DeviceNet Module Status LED States
state

summary

description

Solid Green

Normal

Normal operation

Solid Red

Unrecoverable major
fault

A fault the requires user intervention has been
detected. Correct the problem and reset the linking
device

Flashing Red

Recoverable minor
fault

A fault that can be corrected and does not require a
linking device reset has been detected

Ethernet Link LED
The Ethernet Link LED indicates that the module is connected to an Ethernet network. The
LED displays green if the link is active. The LED will flash when Ethernet packets are
received and transmitted.

Ethernet Network Status LED
Table 11 Ethernet Network Status LED States
state

summary

description

Off

No IP Address

The module has no IP address assigned

Solid Green

Network OK and
communicating

There is at least one EtherNet/IP connection

Flashing Green

Network OK

There are no active connections

Solid Red

Address conflict

The module’s IP address is already in use by another
module

Flashing Red

Connection Time-out

One or more of the connections in which this
module is the target has timed out. This state is only
left if all timed out connections are re-established
or if the module is reset.

Red,Green

Self Test

A self-test of the module is in progress

Alternate Flashing

CIP Link LED
The CIP Link LED indicates bridged and gateway activity between EtherNet/IP and
DeviceNet. The LED will flash green when a CIP message is bridged from EtherNet/IP to
DeviceNet. The LED will be solid green if an EtherNet/IP I/O connection is active.
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Using Diagnostic Web Pages
Status
The Status page displays the linking device identification information, current status, and IP
configuration. The module status is updated approximately every 2.5 seconds.

Active Nodes
The Active Nodes page indicates which DeviceNet nodes are currently configured as slaves
to the linking device’s DeviceNet scanner. Each node that is configured as a slave will be
displayed with “Active” next to the node’s MAC ID.

Idle Nodes
The Idle Nodes page indicates which DeviceNet nodes are currently in the Idle state. If a
node is Idle, the page will display “Idle” next to the node’s MAC ID. Note that only nodes
configured as slaves to the linking device and the linking device itself are updated on this
page.

Faulted Nodes
The Faulted Nodes page indicates which DeviceNet nodes are currently in a faulted state. If a
node is faulted, the page will display “Faulted” next to the node’s MAC ID. Note that only
nodes configured as slaves to the linking device and the linking device itself are updated on
this page.
A node is considered faulted if the linking device has lost communications or is unable to
establish communications with the node. The actual problem can be determined by viewing
the Node Status web page.

Invalid Nodes
The Invalid Nodes page indicates which DeviceNet nodes are not the correct device type. If a
node’s device type is different than that configured in the scan list, the page will display
“Invalid” next to the node’s MAC ID. Note that only nodes configured as slaves to the linking
device are updated on this page.
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Node Status
The Node Status page displays the current status of all DeviceNet nodes that are configured
as slaves to the linking device and the linking device itself. The status of each node is
displayed next to the node’s MAC ID. Note that only nodes configured as slaves to the linking
device and the linking device itself are updated on this page.
The page will display the status textually for many of the common status values. However, to
save web page size, many of the status values are only displayed numerically. Table 12, below,
describes the meaning of each status value.
Table 12 Node Status Codes
this status code

means

so you should

0

Ok

Do nothing

60

Duplicate MAC ID test in progress

Do nothing

70

Module failed Duplicate Node Address check

Change the module address to
another available one. The node
address you selected is already in
use on that network.

71

Illegal data in scan list table

Reconfigure the scan list table and
remove any illegal data

72

Slave device stopped communicating

Inspect the field devices and verify
connections

73

Device’s identity information does not match
electronic key in scan list table entry

Verify that the correct device is at
this node number. Make sure that
the device at the scrolling node
address matches the desired
electronic key (vendor, product
code, product type, etc.).

74

Data overrun on port detected

Modify your configuration and
check for invalid data. Check
network communication traffic.

75

No traffic detected on the network

Check the network configuration

76

No direct network traffic for module detected

None. The module hears other
network communication.

77

Data size expected by the device does not
match scan list entry

Reconfigure your module for the
correct transmit and receive data
sizes

78

Slave device in scan list table does not exist

Add the device to the network, or
delete the scan list entry for that
device
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Table 12 Node Status Codes (Continued)
this status code
79

means
Module has failed to transmit a message

so you should
Make sure that your module is
connected to a valid network.
Check for disconnected cables.

80

Module is in IDLE mode

Put controller in RUN mode.
Enable RUN bit in module
command register.

81

Module is in FAULT mode

Check Module Command Register
for fault bit set

82

Error detected in sequence of fragmented I/O
messages from device

Check scan list table entry for
slave device to make sure that
input and output data lengths are
correct. Check slave device
configuration.

83

Slave device is returning error responses when
module attempts to communicate with it

Check accuracy of scan list table
entry. Check slave device
configuration. Slave device may
be in another master’s scan list.
Reboot slave device.

84

Module is initializing the DeviceNet network

None. This code clears itself once
module attempts to initialize all
slave devices on the network.

85

Data size was incorrect for this device at
runtime

Slave device is transmitting
incorrect length data. Try replacing
the device.

86

Device is producing zero length data (idle state)
while module is in Run Mode

Check device configuration and
slave node status

87

The primary owner has not allocated the slave

Put the primary owner on line

88

The connection choices (polled, strobed, etc.)
between the primary connection and the
shared input only connection do not match

Reconfigure the shared input only
connection's choice(s) to be the
same as, or a subset of, the
primary connection's choice(s)

89

Slave device initialization using Auto Device
Replacement parameters failed

Put the slave device into
configurable mode.
Check the slave's EDS file, if the
slave is configured offline.
Check to see if the slave device
has been replaced with an
incompatible device.

90

User has disabled communication port
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Table 12 Node Status Codes (Continued)
this status code

means

so you should

91

Bus-off condition detected on comm port.
Module is detecting communication errors.

Check DeviceNet connections and
physical media integrity. Check
system for failed slave devices or
other possible sources of network
interference.

92

No network power detected on communication
port

Provide network power. Make sure
that module drop cable is
providing network power to
module comm port.

95

Application FLASH update in progress

Do nothing. Do not disconnect the
module while application FLASH is
in progress. You will lose any
existing data in the module’s
memory.

96

COMM port in Test mode

Do nothing

97

Module operation halted by user command

Check Module Command Register
for HALT bit set

98

General firmware error

Replace module

99

System failure

Replace module

IP Configuration
The IP Configuration web page is used to change the IP configuration of the linking device.

Security
Use the Security web page to change the security password.
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Specifications
Table 13 Specifications
specification

value

DeviceNet Power Requirements

DeviceNet Current Draw

Power will be connected to the EN2DN using a 2 position screw
terminal (Phoenix) connector.
Operating Voltage: 7 to 32 V dc (24 V dc nominal)
100 mA at 24 V Class 2

Linking Device Current Draw

300 mA at 24 V Class 2

Operational Temperature

IEC 60068-2-1 (Test Ad, Operating, Cold)
IEC 60068-2-2 (Test Bd, Operating Dry Heat)
IEC 60068-2-14 (Test Nb, Operating Thermal Shock):
0 to 60 °C (32 to 140 °F)

Storage Temperature

IEC 60068-2-1 (Test Ab, Un-packaged Non-operating Cold)
IEC 60068-2-2 (Test Bb Un-packaged Non-operating Dry Heat)
IEC 60068-2-14 (Test Na, Unpackaged Non-operating Thermal Shock):
-40 to 85 °C (-40 to 185 °F)

Relative Humidity

IEC 60068-2-30 (Test Db, Un-packaged, Non-operating Damp Heat):
5 to 95% non-condensing

Operating Shock

IEC 60068-2-27 (Test Ea, Unpackaged shock):
Operating 30g
Non-operating 50g

Vibration

IEC 60068-2-6 (Test Fc, Operating):
5g @10-500Hz

Emissions

CISPR 11:
Group 1, Class A

ESD Immunity

IEC 61000-4-2:
6kV contact discharges
8kV air discharges

Radiated RF Immunity

IEC 61000-4-3:
10V/m with 1kHz sine-wave 80%AM from 30MHz to 2000MHz
10V/m with 200Hz 50% Pulse 100%AM at 900MHz
10V/m with 200Hz 50% Pulse 100%AM at 1890MHz

EFT/B Immunity

±2kV at 5kHz on power ports
±2kV at 5kHz on signal ports

Surge Transient Immunity

IEC 61000-4-5:
±500V line-line (DM) and ±1kV line-earth (CM) on DC power ports
±1kV line-earth (CM) on signal ports

Continuous Isolation Voltage

50V
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Table 13 Specifications
specification

value

Enclosure Type Rating

None (open-style)

Power Conductors

12 AWG (3.31 sq. mm) maximum, 24 AWG (0.205 sq. mm) minimum
copper wire 75 °C minimum
Catergory 21

Torque

5 - 7 in.-lbs. (0.5 - 0.8 Nm)

DeviceNet and EtherNet
Conductors

Category 21,2

Certifications (when product is
marked)

c-UL-us: UL Listed for Class I, Division 2 Group A,B,C,D Hazardous
Locations, certified for U.S. and Canada
CE3: European Union 89/336/EEC EMC Directive, compliant with:
EN 50082-2; Industrial Immunity
EN 61326; Meas./Control/Lab., Industrial Requirements
EN 61000-6-2; Industrial Immunity
EN 61000-6-4; Industrial Emissions
3

C-Tick : Australian Radiocommunications Act, compliant with:
AS/NZS CISPR 11; Industrial Emissions
3

EEx : European Union 94/9/EC ATEX Directive, compliant with:
EN 50021; Potentially Explosive Atmospheres, Protection “n”
(Zone 2)
ODVA: ODVA conformance tested to DeviceNet specifications
EtherNet/IP: ODVA conformance tested to EtherNet/IP specifications
1 Use this conductor information for planning conductor

routing. Refer to Allen-Bradley publication 1770-4.1 (“Industrial
Automation Wiring and Grounding Guidelines”) or appropriate System Level Installation Manual.

2 Use this Conductor Category information for planning conductor

routing as described in the appropriate System Level

Installation Manual
3

See the Product Certification link at www.ab.com for Declarations of Conformity, Certificates, and other certification details.
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Dimensions

2 in.
(52.7 mm)

4.3 in.
(100.2 mm)
.425 in.
(10 mm)

2.4 in.
(63 mm)

2.69 in.
(68.2 mm)

31444-M

DeviceNet Connector Pinouts
1

2

3

4

5

31422-M

Table 14 DeviceNet Pinouts
pin

signal

1

V-

2

CAN_L

3

Shield

4

CAN_H

5

V+
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EtherNet/IP RJ45 Connector Pinouts

31423-M

Table 15 EtherNet/IP Pinouts
pin

signal

1

TD+

2

TD-

3

RD+

4

Termination

5

Termination

6

RD-

7

Termination

8

Termination
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Notes:
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Notes:
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Rockwell Automation Support
Rockwell Automation provides technical information on the web to assist you in using our
products. At http://support.rockwellautomation.com, you can find technical manuals, a
knowledge base of FAQs, technical and application notes, sample code and links to software
service packs, and a MySupport feature that you can customize to make the best use of these
tools.
For an additional level of technical phone support for installation, configuration and
troubleshooting, we offer TechConnect Support programs. For more information, contact
your local distributor or Rockwell Automation representative, or visit
http://support.rockwellautomation.com.

Installation Assistance
If you experience a problem with a hardware module within the first 24 hours of installation,
please review the information that's contained in this manual. You can also contact a special
Customer Support number for initial help in getting your module up and running:
United States

1.440.646.3223
Monday – Friday, 8am – 5pm EST

Outside United States

Please contact your local Rockwell Automation representative for any technical
support issues.

New Product Satisfaction Return
Rockwell tests all of our products to ensure that they are fully operational when shipped from
the manufacturing facility. However, if your product is not functioning and needs to be
returned:
United States

Contact your distributor. You must provide a Customer Support case number (see
phone number above to obtain one) to your distributor in order to complete the return
process.

Outside United States

Please contact your local Rockwell Automation representative for return procedure.

Publication 1788-IN055A-EN-P - October 2003

PN 957782-94
Copyright © 2003 Rockwell Automation, Inc. All rights reserved. Printed in the U.S.A.

